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1 Introduction

ne is a full screen text editor for UN*X (or, more precisely, for POSIX: see Chapter 7 [Motivations and
Design], page 65). I came to the decision to write such an editor after getting completely sick of v1, both
from a feature and user interface point of view. I needed an editor that I could use through a telnet
connection or a phone line and that wouldn’t fire off a full-blown LITHP! operating system just to do
some editing.

A concise overview of the main features follows:

e three user interfaces: control keystrokes, command line, and menus; keystrokes and menus are
completely configurable;

e syntax highlighting;

o full support for UTF-8 files, including multiple-column characters;

e 064-bit file/line length;

e simple scripting language where scripts can be generated via an idiotproof record/play method;
e unlimited undo/redo capability (can be disabled with a command);

e automatic preferences system based on the extension of the file name being edited or regex content
matching;

e automatic completion of prefixes using words in your documents as dictionary;
e a file requester with completion features for easy file retrieval;
e extended regular expression search and replace a la emacs and vi;

e avery compact memory model—you can easily load and modify very large files, even if they do not
fit your core memory;

e cditing of binary files.

L This otherwise unremarkable language is distinguished by the absence of an ‘s’ in its character set; users must substitute
‘th’. LITHP is said to be useful in protheththing lithtth.
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2 Basics

Simple things should be simple. Complex things should be possible. (Alan Kay)

ne’s user interface is essentially a compromise between the limits of character driven terminals and
the power of GUIs. While real editing is done without ever touching a mouse, it is also true that editing
should be doable without ever touching a manual. These two conflicting goals can be accommodated
easily in a single program if we can offer a series of interfaces that allow for differentiated use.

In other words, it is unlikely that an ne wizard will ever have to activate a menu, but to become an
expert user you just have to use the menus enough to learn by heart the most important keystrokes. A
good manual is always invaluable when one comes to configuration and esoteric features, but few users
will ever need to change ne’s menus or key bindings.

Another important thing is that powerful features should always be accessible, at least in part, to every
user. The average user should be able to record his actions, replay them, and save them in a humanly
readable format for further use and editing.

In the following sections we shall take a quick tour of ne’s features.

2.1 Terminology

In this section we explain and contrast some of the terms ne uses. Understanding these distinctions will
go a long way towards making the rest of this manual make sense.

A file is a group of bytes stored on disk. This may seem rather obvious, but the important distinction
here is that ne does not edit files; it edits documents.

A document is what ne calls one of the “text thingies” that you can edit. It is a sequence of lines of
text in the computer’s memory—not on disk."! Documents can be created, edited, saved in files, loaded
from files, discarded, et cetera. When a document is loaded from or saved to a file, it remains associated
with that file by name until the document is either closed or saved to a different file. Interactions between
documents and files are handled by the commands under the ‘File’ menu. The ‘Documents’ menu
commands only deal with documents. See Section 3.7 [Menus], page 17.

Internally, ne holds its documents in buffers. A buffer is a chunk of memory in which ne holds
something. For example, each document is held in its own buffer, as are any loaded or recorded macros,
undo records, a copy of your last deleted line of text, a copy of all your previous responses to long input,
and several other things.

2.2 Starting

To start ne, just type ‘ne’ and press RETURN. If you want to edit some specific file(s), you can put their
name(s) on the command line just after the command name, as for any UN*X command. The screen of
your terminal will be cleared (or filled with text loaded from the first file you specified). You can also
pipe the result of a command directly into ne: it will be loaded and opened as the first document. See
Section 3.1 [Arguments], page 11 for other command line options.

Writing text is pretty straightforward: if your terminal is properly configured, every key will (should)
do what you expect. Alphabetic characters insert text, cursor keys move the cursor, and so on. You can
use the DELETE and BACKSPACE key to perform corrections. If your keyboard has an INSERT key,
you can use it to toggle (switch from on to off, or vice versa) insert mode. In general, ne tries to squeeze
everything it can from your keyboard. Function keys and special movement keys should work flawlessly
if your terminal is properly configured. If not, complain to your system administrator. If that doesn’t
help, see Section 5.1 [Key Bindings], page 59.

! Actually, it can be in a region of the disk used to simulate a larger memory. ne will switch to such a simulation whenever the
computer’s memory is not sufficient for editing a file. This means, in particular, that out-of-memory errors can be caused
by insufficient disk space, too.
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At the bottom of the screen, you will see a line containing some numbers and letters. This is called
the status bar because it reports to you part of the internal state of the editor. At startup, the status bar
has the following form:

L: 1 C: 1 12% ia—-——-pvu-t-————- @Ax <unnamed>

(the numbers could be different, and a file name could be shown as last item instead of ‘<unnamed>’).
You probably already guessed that the numbers after ‘1,:” and ‘C:’ are your cursor’s line and column
numbers, respectively, whereas the percentage indicates approximately your position in the file. The
small letters represent user flags that you can turn on and off. In particular, ‘i’ tells you that insert mode
is on, while ‘p’ tells that the automatic preferences system is activated. The ‘»’ means this buffer has
not been saved. For a thorough explanation of the meaning of the flags on the status bar, see Section 3.2
[The Status Bar], page 12.

bl

Once you are accustomed to cursor movement and line editing, it is time to press F1 (the first function
key), or in case your keyboard does not have such a key, ESCAPE. Immediately, the menu bar will
appear, and the first menu will be drawn. (If you find yourself waiting for the menu to appear, you can
press ESCAPE twice in a row.) You can now move around menus and menu items by pressing the cursor
keys. Moreover, a lower case alphabetic key will move to the next item in the current menu whose name
starts with that letter, and an upper case alphabetic key will move to the next menu whose name starts
with that letter.

Moving around the menus should give you an idea of the capabilities of ne. If you want to save
your work, you should use the ‘save As. ..’ item from the ‘File’ menu. Menus are fully discussed in
Section 3.7 [Menus], page 17. When you want to exit from the menu system, press F1 (or ESCAPE)
again. If instead you prefer to choose a command and execute it, move to the respective menu item and
press RETURN.

At the end of several menu items you will find strange symbols like ~ 4 or F1. They represent shortcuts
for the respective menu items. In other words, instead of activating, selecting and executing a menu item,
which can take seconds, you can simply press a couple of keys. The symbol ‘"’ in front of a character
denotes the shortcut produced by the CONTROL key plus that character (we assume here that you are
perfectly aware of the usage of the CONTROL key: it is just as if you had to type a capital letter
with SHIFT). The descriptions of the form Fn represent instead function keys. Finally, the symbol
‘[’ in front of a character denotes the shortcut produced by CONTROL plus META (a.k.a. ALT) plus
that character, or META plus that character, depending on your terminal emulator—you must check for
yourself. Moreover, these last bindings may not work with some terminals, in which case you can replace
them with a sequence: just press the ESCAPE key followed by the letter. A few menu items are bound
to two control sequences (just in case one does not work, or it is impractical).

Note that under certain conditions (for instance, while using ne through a telnet connection) some
of the shortcuts might not work because they are trapped by the operating system for other purposes (see
Chapter 6 [Hints and Tricks], page 63).

Finally, we have the third and last interface to ne’s features: the command line. If you press
CONTROL-K, or ESCAPE followed by ‘:” (a la vi), you will be requested to enter a command to ex-
ecute. Just press RETURN for the time being (or, if you are really interested in this topic, see Section 3.4
[The Command Line], page 15).

In the sections that follow, when explaining how to use a command we shall usually describe the
corresponding menu item. The related shortcut and command can be found on the menu item itself, and
in Section 3.7 [Menus], page 17.

2.3 Loading and Saving

The first thing to learn about an editor is how to exit. ne has a CloseDoc command that can be activated
by pressing CONTROL-Q, by choosing the ‘Close’ item of the ‘Document’ menu, or by activating the
command line with CONTROL-K, writing ‘cd’ and pressing RETURN. Its effect is to close the current
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document without saving any modifications. (You will be requested to confirm your choice in case the
current document has been modified since the last save.)

There is also a Quit command, which closes all the documents without saving any modifications,
and a SavesExit (META-X) command, which saves the modified documents before quitting.

This choice of shortcuts could surprise you. Wouldn’t ‘Quit’ be a much better candidate for
CONTROL-Q? Well, experience shows that the most common operation is closing a document rather
than quitting the editor. If there is just one document, the two operations coincide (this is typical, for
instance, when you use ne for writing electronic mail), and if there are many documents, it is far more
common to close a single document than all the existing documents.

If you want to load a file, you may use the Open command, which can be activated by pressing
CONTROL-0, by choosing the ‘Open. ..’ item of the ‘File’ menu, or by typing it on the command line
(as in the previous case). You will be prompted with a list of files and directories in the current working
directory. (You can tell the directory names because they end with a slash; they will also appear in a
bold face if your terminal allows it.) You can select any of the file names by using the cursor keys, or
any other movement key. Pressing an alphabetic key will move the cursor to the first entry after the
cursor that starts with the given letter. When the cursor is positioned over the file you want to open, press
RETURN, and the file will be opened. If instead you move to a directory name, pressing RETURN will
display the contents of that directory.

You can also escape with F1, ESCAPE or ESCAPE-ESCAPE and manually type the file name on the
command line (or escape again, and abort the Open operation). If you escape with TAB instead, the file
or directory under the cursor will be copied to the input line, where you can modify it manually. ne also
has file name completion features activated by TAB (see Section 3.3 [The Input Line], page 14).

When you want to save a file, just use the command save (CONTROL-S). It will use the current
document name or will ask you for one if the current document has no name. SaveAs, on the other hand,
will always ask for a new name before saving the file. saveall will save all modified documents. If the
file you are saving a document to has changed since you last loaded or saved it, perhaps because another
user updated it while you were editing, ne will warn you before overwriting the file.

If ne is interrupted by an external signal (for instance, if your terminal crashes), it will try to save
your work in some emergency files. These files will have names similar to your current files, but they
will have a pound sign ‘4’ prefixed to their names. See Section 3.10 [Emergency Save], page 25.

2.4 Editing

An editor is presumably used for editing text. If you decide not to edit text, you probably don’t want to
use ne, because that’s all it does—it edits text. It does not play Tetris. It does not evaluate recursive
functions. It does not solve your love problems. It just allows you to edit text.

The design of ne makes editing extremely natural and straightforward. There is nothing special you
have to do to start editing once you’ve started ne. Just start typing, and the text you type shows up in
your document.

ne provides two ways of deleting characters: the BACKSPACE key (or CONTROL-H, if you have no
such key) and the DELETE key. In the former case you delete the character to the left of the cursor,
while in the latter case you delete the character just under the cursor. This is in contrast with many
UN*X editors, which for unknown reasons decide to limit your ways of destroying things—something
notoriously much funnier than creating. (See Section 4.11.4 [DeleteChar], page 54 and Section 4.11.7
[Backspace], page 54.)

If you want to delete a line, you can use the DeleteLine command, or CONTROL-Y. A very nice
feature of ne is that each time a nonempty line is deleted, it is stored in a temporary buffer from which
it can be undeleted via the UndelLine command or CONTROL-U. (See Section 4.11.9 [DeleteLine],
page 55 and Section 4.7.3 [UndelLine], page 38.)
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If you want to copy, cut, paste, shift or erase a block of text, you have to set a mark. This is done
via the Mark command, activated by choosing the ‘Mark Block’ item of the ‘Edit’ menu, or by press-
ing CONTROL-B (think “block™). This command sets the invisible mark at the current cursor position.
Whenever the mark is set, the text between the mark and the cursor can be cut, copied or erased. Note
that by using CONTROL-@ you can set a vertical mark instead, which allows you to mark rectangles of
text. Whenever a mark has been set, either an ‘M’ appears on the command line or a ‘v’ appears if the
mark is vertical. If you forget where the mark is currently, you can use the ‘Goto Mark’ menu item of
the ‘search’ menu to move the cursor to it.

The block of text you cut or copy is saved in a clip, which you can ‘Paste’ somewhere else in your
document, or save it to a file with the ‘Save Clip...’ menu item of the ‘Edit’ menu. You can also
load a file directly into a clip with ‘Open Clip...’, and ‘Paste’ it anywhere. All such operations act
on the current clip, which is by default the clip 0. You can change the current clip number with the
ClipNumber command. See Section 4.4.11 [ClipNumber], page 32.

One of the most noteworthy features of ne is its unlimited undo/redo capability. Each editing action
is recorded, and can be played back and forth as much as you like. Undo and redo are bound to the
function keys F5 and F6.

Another interesting feature of ne is its ability to load an unlimited number of documents. If you
activate the NewDoc command (using the ‘Document’ menu or the command line), a new, empty doc-
ument will be created. You can switch between your documents with F2 and F3, which are bound to
the PrevDoc and NextDoc commands. If you have a lot of documents, the ‘Select...’ menu item
(F4) prompts you with the list of names of currently loaded documents and allows you to choose directly
which to edit. In that list, names of documents with unsaved changes will be bold. You can also change
their relative order in that list with the F2 and F3 keys.

2.5 Basic Preferences

ne has a number of flags that specify alternative behaviors, the most prototypical example being the
insert flag, which specifies whether the text you type is inserted into the existing text or replaces it. You
can toggle this flag with the ‘Insert’ menu item of the ‘Prefs’ menu, or with the INSERT key of
your keyboard. (Toggle means to change the value of a flag from true to false, or from false to true; see
Section 4.9.4 [Insert], page 42.)

Another important flag is the free form flag, which specifies whether the cursor can be moved beyond
the right end of each line of text or only to existing text (a la vi). Programmers usually prefer non free
form editing; text writers seem to prefer free form. See Section 4.9.6 [FreeForm], page 42 for some
elaboration. The free form flag can be set with the ‘Free Form’ menu item of the ‘Prefs’ menu.

At this point, we suggest you explore by trial and error the other flags of the ‘Prefs’ menu, or try
the Flags command (see Section 4.9.1 [Flags], page 40), which explains all the flags and the commands
that operate on them. We prefer spending a few words discussing automatic preferences or autoprefs,
and default preferences or defprefs.

Having many flags ensures a high degree of flexibility, but it can turn editing into a nightmare if
you have to turn on and off dozens of flags for each different kind of file you edit. ne’s solution is
to load your default preferences whenever ne is run before loading any file, then additionally set your
stated preferences automatically for each file type as files are loaded. A file’s type is determined by the
extension of its file name, that is, the last group of letters after the last dot. For instance, the extension
of ‘ne.texinfo’ is ‘texinfo’, the extension of ‘source.c’ is ‘c’, and the extension of ‘my.txt’ is

3 ’

txt'.

Thus, when you select the ‘Save Def Prefs’ menu item or the SaveDefPrefs command, a spe-
cial preferences file named ‘.default#ap’ is saved. In addition to other preferences, this file also
includes a small set of preferences which are global to ne rather than specific to particular document
types. These preferences are: FastGUI, RequestOrder, StatusBar and VerboseMacros; see Sec-
tion 4.9.5 [FastGUI], page 42, See Section 4.9.8 [RequestOrder], page 42, See Section 4.9.9 [StatusBar],
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page 43, and See Section 4.9.18 [VerboseMacros], page 45. These extra preferences are not saved by the
SaveAutoPrefs command.

By contrast, whenever you select the ‘Save AutoPrefs’ menu item, ne saves the flags of your
current document to be used when you load other files with the same extension. These autoprefs are
saved in a file in your ‘~/.ne’ directory. This file has the same name as the extension of the current
document with ‘#ap’ appended to it. It contains all the commands necessary to recreate your current
document’s flag settings. Whenever you open a file with this file name extension, ne will automagically
recreate your preferred flag settings for that file type. (There is a flag that inhibits the process; see
Section 4.9.2 [AutoPrefs], page 41.)

Similar to preference flags, the current syntax definition is specific to the current document type, so it
also is saved in autoprefs files by the SaveAutoPrefs command or ‘Save AutoPrefs’ menu,; it is not
saved in the ‘.default#ap’ file.

3

Note that a preferences file—whether ‘.default#ap’ or an AutoPrefs file— is just a macro (as
described in the following section). Thus, it can be edited manually if necessary.

Some files have no extension, but the file type can be discerned by simple examination. Consider
for example a file named ‘example’ which contains XML. You may reasonably expect it to be treated
as an ‘.xml’ file rather than a generic file. For the purposes of applying automatic preferences and
syntax definitions, ne provides a mechanism for overriding a wrong or missing extension with a virtual
extension based on a document’s contents. You do this by creatinga *~/.ne/.extensions’ file which

is fully described in the Section 5.3 [Virtual Extensions], page 61 section.

2.6 Basic Macros

Very often, the programmer or the text writer has to repeat some complex editing action over a series of
similar blocks of text. This is where macros come in.

A macro is a stored sequence of commands. Any sequence of commands you find yourself repeating
is an excellent candidate for being made into a macro. You could create a macro by editing a document
that only contains valid ne commands and saving it, but by far the easiest way to create a macro is to
have ne record your actions. ne allows you to record macros and then play them (execute the commands
they contain) many times. You can save them on disk for future use, edit them, or bind them to any key.
You could even reconfigure each key of your keyboard to play a complex macro if you wanted to.

ne can have any number of named macros loaded at the same time. It can also have one unnamed
macro in its current macro buffer. The named macros are typically loaded from disk files, while the
current macro buffer is where your recorded macro is held before you save it or record over it.

Recording a macro is very simple. The keystroke CONTROL-T starts and stops recording a macro.
When you start recording a macro, ne clears the current macro buffer and starts recording all your
actions (with a few exceptions). You can see that you are recording a macro if an ‘R’ appears on the
status bar. After you stop the recording process (again using CONTROL-T), you can play the macro with
the ‘Play Once’ item of the ‘Macros’ menu or with the F9 key. If you want to repeat the action many
times, the P1ay command allows you to specify a number of times to repeat the macro. You can always
interrupt the macro’s execution with CONTROL-\.

A recorded macro has no name. It’s just an anonymous sequence of commands in the current macro
buffer, and it will go away when you exit ne or record another macro. If you want to save your recorded
macro for future use, you can give it a name and save it with the ‘Save Macro. ..’ menu item or the
SaveMacro command. The macro is saved as a regular text file in your current directory by default or
whatever directory you specify when prompted for the macro’s name. If you save it in your ‘~/.ne’
directory then it will be easy to access it later from any other directory. The ‘Open Macro. ..’ menu
item and the OpenMacro command load a macro from a file into the current macro buffer just as if you
had just Recorded it.

The current setting of your VerboseMacros flag determines whether long or abbreviated command
names are used when saving a macro. For your convenience, SaveMacro will also convert sequences
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of InsertChar commands into single—usually much more readable— InsertString commands, but
only if all the inserted characters are simple printable characters, and only if there are no subsequent
Undo commands or macro invocations.

Any macro can be loaded from a file and played with the ‘P1ay Macro. ..’ menu item or the Macro
command. (This won’t modify the recorded anonymous macro that may be in the current macro buffer;
OpenMacro does that.) Useful macros can be permanently bound to a keystroke as explained in Sec-
tion 5.1 [Key Bindings], page 59. Moreover, whenever a command line does not specify one of ne’s
built in commands, it is assumed to specify the name of a macro to execute. Thus, you can execute
macros just by typing their file names. Include a path if the macro file’s directory is different from your
current directory or your ‘~/.ne’ directory.

If the first attempt to open a macro fails, ne checks for a macro with the given name in your *~/ .ne’
directory. This allows you to program simple extensions to ne’s language. For instance, all automatic
preferences macros—which are just specially named macros that contain only commands to set pref-
erences flags—can be executed just by typing their names. For example, if you have an automatic
preference for the ‘doc’ extension for example, you can set ne’s flags exactly as if you had loaded a file
ending with ‘. doc’ by typing the command doc#ap.

In general, it is a good idea to save frequently used macros in ‘~/.ne’ so that you can invoke them
by name without specifying a path regardless of your current directory. On the other hand, if you have
a macro that is customized for one document or a set of documents that you store in one directory, then
you might want to save the macro in that directory instead. If you do, then you would want to cd to that
directory before you start ne so that you can access that macro without specifying a path.

If your macro has the same name as one of ne’s built-in commands, you can only access it with the
Macro name command. Built-in command names are always searched before the ne command inter-
preter looks for macros.

The system administrator may make some macros available from the ‘macros’ subdirectory of ne’s
global directory. See Section 3.1 [Arguments], page 11.

Since loading a macro each time it is invoked would be a rather slow and expensive process, once a
macro has been executed it is cached internally. Subsequent invocations of the macro will use the cached
version.

Warning: while path and file names are case sensitive when initially loading macros, loaded macro
names are not case sensitive or path sensitive. ne only caches the file name of an already loaded macro,
not the path, and uses a case insensitive comparison when resolving command names. As such, if you
invoke ‘~/foobar/MyMacro’, ne remembers it with the case-insensitive name ‘mymacro’; a subsequent
call for ‘/usr/MYMACRO’ will instead find and use the cached version of ‘~/foobar/MyMacro’. You
can clear the cache by using the UnloadMacros command. See Section 4.6.6 [UnloadMacros], page 37.

The behaviour of macros may vary with different preferences. If the user changes the AutoIndent
and WordwWrap flags, for example, new lines and new text may not appear in the same way they would
have when a macro was recorded. Good general purpose macros avoid such problems by using the
pPushPrefs command first. This preserves the user’s preferences. Then they set any preferences that
could affect their behaviour. Once that is taken care of they get on with the actual work for which they
were intended. Finally, they use the PopPrefs command to restore the user’s preferences. Note that
if a macro is stopped before it restores the preferences (either by the user pressing CONTROL-\ or by a
command failing) then dealing with the changed preferences falls to the user.

Any changes made to a document by a macro are recorded just as if you had entered the commands
yourself. Therefore you can use the Undo command to roll back those changes one at a time. This
can be useful especially when developing macros, but you may want to be able to undo all the changes
made by a macro with a single Undo command. The AtomicUndo command makes this possible. If
you add AtomicUndo + at the start of your macro and AtomicUndo — at the end, then the Undo and
Redo commands will handle all changes made by your macro atomically, i.e., as if they had been made
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by a single command, even if your macro calls other macros which could themselves contain matching
AtomicUndo + and AtomicUndo — commands. See Section 4.7.5 [AtomicUndo], page 38.

Finally, any line in a macro that starts with a non-alphabetical character is considered a comment, so
you can add comments to a macro by starting a line with ‘#’.

2.7 More Advanced Features

2.7.1 UTF-8 support

ne can load and manipulate UTF-8 files transparently, in particular on systems that provide UTF-8 1/O.
See Section 3.11 [UTF-8 Support], page 25.

2.7.2 Bookmarks

It often happens that you have to browse through a file, switching frequently between a small num-
ber of positions. In this case, you can use bookmarks. There are up to ten bookmarks per document,
each designated by a single digit, with the default being ‘0’. You can set them with the SetBookmark
command, and you can return to any set bookmark with the GotoBookmark command. Also, ne sets
an automatic bookmark (designated by ‘-’) at your current position in a document whenever you use
the GotoBookmark command. You can use a GotoBookmark — command to return to the location
of the previous GotoBookmark command. Doing so will reset the automatic bookmark, so that sub-
sequent GotoBookmark — commands will switch between those two locations. The special parame-
ters ‘+1° and ‘-1’ indicate the next or previous set bookmark in conjunction with Got oBookmark and
UnsetBookmark, but reference the next or previous unset bookmark when used with setBookmark.
A sequence of GotoBookmark +1 commands lets you easily cycle through all your set bookmarks. Fi-
nally, the special parameter ‘?’ causes Set Bookmark and Got oBookmark to prompt you for a bookmark
designation. This prompt includes an indication of which bookmarks are already set for the current doc-
ument. See Section 4.10.26 [SetBookmark], page 52, Section 4.10.27 [GotoBookmark], page 53, and
Section 4.10.28 [UnsetBookmark], page 53. Note that in the default configuration no key binding is
assigned to these commands. If you use them frequently, you may want to change the key bindings. See
Section 5.1 [Key Bindings], page 59.

2.7.3 Automatic Completion

The Aut oComplete command helps you extend a given prefix with matching words from your open doc-
uments. You can specify the Aut oCompete command and prefix on the command line, or you can enter
the prefix directly into your document and activate the AutoComplete command. With the cursor at the
right end of your prefix, activate the AutoComplete command by entering either the ESCAPE-TAB or
the ESCAPE-I key sequence, or the CONTROL-META-TI key combination, or by selecting AutoComplete
from the Extras menu.

If the prefix can be extended unambiguously, the extension will be immediately inserted into your
document (this is the case, for instance, if only one word matches the prefix), and a message will tell you
whether the extension is an actual word or just the longest possible extension (for instance, if you expand
‘fo’ and your document contains ‘foobar’ and ‘foofoo’ then the partial match will be ‘foo’). Other-
wise, ne presents you with a list of all matching words: choose the one you want and press RETURN, to
select it; otherwise, press F1, ESCAPE or ESCAPE-ESCAPE to cancel the completion operation.

The current state of the Casesearch flag determines whether the prefix match is case sensitive. Any
matching words which only exist in other open documents but not the current one are displayed in bold
with an asterisk; think of that as a warning that if you select one of these bold words you will introduce
a new word into your current document. Plain words already exist somewhere in your current document.
See Section 4.5.11 [AutoComplete], page 35, and Section 4.5.10 [CaseSearch], page 35.
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2.7.4 Automatic Bracket Matching

Unless you tell it not to (with the AutoMatchBracket command), ne will highlight any recognized
bracket that matches the bracket your cursor is on if that matching bracket is currently visible on your
screen. Recognized bracket pairs are ‘{}°, “()’, ‘[1°, ‘<>’, and ‘*’’. See Section 4.5.8 [AutoMatch-
Bracket], page 35.

2.7.5 MS-DOS files

ne will detect automagically the presence of MS-DOS line terminators (CR/LFs) and set the CR/LF
flag. When the file will be saved, the terminators will be restored correctly. You can change this be-
haviour using the PreserveCR and CRLF commands. See Section 4.9.19 [PreserveCR], page 45, and
Section 4.9.20 [CRLF], page 45.

2.7.6 Binary files

ne allows a simplified form of binary editing. If the binary flag is set, only NULLs are considered
newlines when loading or saving. Thus, binary files can be safely loaded, modified and saved. Inserting
a new line or joining two lines has the effect of inserting or deleting a NULL. Be careful not to mismatch
the state of the binary flag when loading and saving the same file.

2.7.7 File requester

The NoFileReq command deactivates the file requester. It is intended for “tough guys” who always
remember the names of their files and can type them at the speed of light (maybe with the help of the
completer, which is activated by the TAB key; see Section 3.3 [The Input Line], page 14).

2.7.8 Executing UN*X commands

There are three ways to execute UN*X commands from within ne. The System command can run
any UN*X command; you will get back into ne as soon as the command execution terminates. See
Section 4.12.10 [System], page 56. The Through (META-T) command (which can be found in the
‘Edit’ menu), however, is much more powerful; it cuts the current block, passes it as standard input
to any UN*X command, and pastes the command’s output at the current cursor position. This provides
a neat way to pass a part of your document through one of UN*X’s many filter commands (commands
that read from standard input and write to standard output, e.g., sort). See Section 4.4.12 [Through],
page 32. Finally, you can use the Suspend (CONTROL-Z) command to temporarily stop ne and return to
your command shell. See Section 4.12.9 [Suspend], page 56.

2.7.9 Advanced key bindings

ne allows you to associate any keystroke with any command, both built-in commands (with or without
parameters) and macros. These associations are refered to as key bindings, which you define in your
“/.ne/.keys file. The KeyCode command allows you to see the key code ne sees in response to any
key or key combination on your keyboard. It also shows the command string currently associated with
that key code. This is described in Section 5.1 [Key Bindings], page 59.

The following chapters provide an exhaustive list of the remaining features of ne. See Chapter 3
[Reference], page 11.
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3 Reference

In this chapter we shall methodically overview each part of ne. It is required reading for becoming an
expert user because some commands and features are not available through menus.

3.1 Arguments

The main arguments you can give to ne are the names of files you want to edit. They will be loaded into
separate documents. If you specify --help anywhere on the command line, a simple help text describing
ne’s arguments will be printed.

The +N option causes ne to advance to the Nth line of the next document loaded. This option is fairly
common among editors and text display programs like vi and less. The N itself is optional. Without it,
a bare + on the command line causes ne to advance to the last line of the first document. You can specify
a line and column as +N, M. Any non-digit can be used to separate the N from the M. As it only affects
the next document loaded, it can appear multiple times on the command line.

The —-binary option causes ne to load the next document in binary mode. Binary mode treats the
normal line termination characters as any other character and only breaks lines on NULL characters.
Like +N, M, ——binary only affects the next document loaded, and it can appear multiple times on the
command line. See Section 4.9.3 [Binary], page 41.

The --read-only option causes ne to load the next named file into a read-only document. You
can still save (Section 4.2.3 [Save], page 28) a read-only document to a file if the file’s permissions
allow it, but you can’t modify a read-only document without taking special action such as turning off the
read-only flag first. The ——read-only option only affects the next document loaded, so it can appear
multiple times on the command line. A document’s read-only flag is automatically set when a file is
loaded if the corresponding file is not writable (as determined by the access () system call) regardless
of whether the --read-only option is used. See Section 4.9.11 [ReadOnly], page 43.

The -—no-config option skips the reading of the key bindings and menu configuration files (see
Chapter 5 [Configuration], page 59). This is essential if you are experimenting with a new configuration
and you make mistakes in it.

The —-prefs extension option makes ne load a specified set of automatic preferences, that is,
those associated with the provided extension, instead of the default ones, before loading the first file. It
can be useful, for instance, when piping a file into ne or when reading from named pipes, as in those
cases there is no file extension from which ne can guess the correct preferences. Note that preferences
are cloned from the current document when a new document is created, so if you open a number of files
without extension this option will propagate to all of them.

The --macro filename option specifies the name of a macro that will be started just after all docu-
ments have been loaded. A typical macro would move the cursor to a certain line.

The -—keys filename option and the ~—-menus filename option specify a name different from the
default one (‘. keys’ and ‘.menus’, respectively) for the key bindings and the menu configuration files.
Note that ne searches for these files first in the current directory, and then in your *~/.ne’ directory.

The —-ansi and the ——no-ansi options manage ne’s built-in ANSI sequences. Usually ne tries to
retrieve from your system some information that is necessary to handle your terminal. If for some reason
this is impossible, you can ask ne to use a built-in set of sequences that will work on many terminals
using the ——ansi option (to be true, ne can be even compiled so that it uses directly the built-in set, but
you need not know this). If you want to be sure (usually for debugging purposes) that ne is not using the
built-in set, you can specify ——no-ansi.

The --no-syntax option disables ne’s normal syntax highlighting capability. For most editing
situations, this would be unnecessary, but for extremely large files it may be helpful. Syntax highlighting
incurs small memory usage and processor overhead penalties for each line of text. The ——no-syntax
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option eliminates that overhead. Note that files longer than ten million bytes will have syntax highlighting
disabled by default, but it is possible to re-enable it. See Section 3.6 [Syntax Highlighting], page 16.

The -—ut £8 and ——no—ut £8 options can be used to force or inhibit UTF-8 /O, overriding the choice
imposed by the system locale. Note, however, that in general it is more advisable to set the LANG
environment variable to a locale supporting UTF-8 (you can usually see the locale list with locale
-a). See Section 3.11 [UTF-8 Support], page 25.

If you need to open a file whose name starts with ‘--’, you can put ‘—-’" before the filename, which
will skip command recognition for the next word.

You can use I/O redirection to pipe the output of other commands into your first document. For
example,

ls -1 | ne filel.txt --read-only file2.txt

will open three documents: an unnamed document containing the output of the 1s -1 command, the
contents of ‘filel.txt’, and the contents of ‘file2.txt’ with the read-only flag set.

It’s possible to apply the —-binary, —~—read-only, and +N, M options to the piped unnamed doc-
ument by referencing it as a single —. Only the first such file name will reference the piped document
(even if it isn’t the first file name on the command line). Subsequent dashes will be considered normal
file names. If you want the first dash to be treated like a normal file instead of a reference to the piped
document, prefix the dash with ‘—-’. Consider these two command lines:

ls -1 | ne —--read-only +3,8 - filel.txt -
ls -1 | ne filel.txt -—- - —--read-only +3,8 -
ls -1 | ne —--binary filel.txt --read-only -- -

All three of these commands open ne with three documents: the output of the 1s -1 command will
be in the first unnamed document, the contents of ‘filel.txt’ will be in the second document, while
the third document will contain the contents of the file ‘-’ (or an empty document with that name if there
is no such file). The first and second commands do exactly the same thing: the unnamed first document
is marked read-only and the cursor is positioned on line 3 column 8, while the other two document
are opened normally. In the case of the third command, ‘filel.txt’ is opened in binary mode, the
document named ‘-’ is marked read-only, while the first, unnamed, document—which is not referenced
on the command line—with the output from 1s -1 is opened normally.

Finally, ne has a global directory where the system administrator can store macros, default prefer-
ences, and syntax definitions for all users of the system. The location of this directory is defined when
ne is built, but you can override it by creating and exporting the NE_GLOBAL_DIR environment variable
prior to invoking ne. If you load no files when you start ne, or if you invoke the About command, it will
display a splash screen. The last line on that screen shows the global directory ne is using, if it exists, or
an error message otherwise.

3.2 The Status Bar

The last line of the screen, the status bar, is reserved by ne for displaying some information about its
internal state. Note that on most terminals it is physically impossible to write a character on the last
column of the last line, so we are not stealing precious editing space.

The status bar looks more or less like this:
L: 31 C: 25 12% iabcwfpvurtBMRPC*(@8 20 /foo/bar

The numbers after ‘L:” and ‘C:’ are the line and column of the cursor position. The first line and the
first column are both number 1. Then, ne shows the percentage of lines before the current line (it will be
0% on the first line, and 100% on the last line).

Following that are a sequence of letters or dashes. These indicate the status of a series of flags which
we shall look at later.
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The hexadecimal digits following the flags give the code for the character at the cursor, and are
displayed optionally (see Section 4.9.10 [HexCode], page 43). If your cursor is at or beyond the right
end of the current line, the code disappears.

The file name appearing after the character code is the file name of the current document. The left
end of very long file names may be truncated to keep the right end visible. Of course, ne is keeping track
internally of the complete file name. It is used by the Save command and as the default input for the
SaveaAs command. See Section 4.2.3 [Save], page 28, and Section 4.2.4 [SaveAs], page 28.

The displayed line and column numbers, the percentage indicator and the character code change when
the cursor moves. This fact can really slow down cursor movement if you are using ne through a slow
connection. If you find this to be a problem, it is a good idea to turn off the status bar using either
the ‘Status Bar’ menu item of the ‘Prefs’ menu or the StatusBar command. See Section 4.9.9
[StatusBar], page 43. Alternatively you can turn on the fast GUI mode using either the ‘Fast GUI’ menu
item of the ‘Prefs’ menu or the FastGUI command (see Section 4.9.5 [FastGUI], page 42). In fast GUI
mode the status bar is not draw in reverse, so some additional optimization can be done when refreshing
it.

The letters after the line and column number represent the status of the flags associated with the
current document. Flags that are off display a ‘-’ instead of a letter. Each flag also has an associated
command. The Flags command describes them all when you don’t have this manual handy. Here’s the
list in detail:

appears if the insert flag is true. See Section 4.9.4 [Insert], page 42.

‘a’ appears if the auto indent flag is true. See Section 4.8.8 [AutoIndent], page 40.
‘b’ appears if the back search flag is true. See Section 4.5.9 [SearchBack], page 35.
‘e’ appears if the case sensitive search flag is true. See Section 4.5.10 [CaseSearch], page 35.

appears if the word wrap flag is true. See Section 4.8.7 [WordWrap], page 40.

£ appears if the free form flag is true. See Section 4.9.6 [FreeForm], page 42.
‘©’ appears if the automatic preferences flag is true. See Section 4.9.2 [AutoPrefs], page 41.
v’ appears if the verbose macros flag is true. See Section 4.9.18 [VerboseMacros], page 45.

appears if the undo flag is true. See Section 4.7.4 [DoUndo], page 38.
r appears if the read only flag is true. See Section 4.9.11 [ReadOnly], page 43.

appears as ‘t’ if the tabs flag is true, ‘T’ if the shifttabs flag is also true. See Section 4.9.14
[Tabs], page 44, Section 4.9.16 [ShiftTabs], page 44.

‘a appears if the deltabs flag is true. See Section 4.9.15 [DelTabs], page 44.
appears if the binary flag is true. See Section 4.9.3 [Binary], page 41.

appears in place of ‘B” when not in binary mode and the last line of the document is not
empty (i.e. the last line of the saved file would not be terminated).

‘M appears if you are currently marking a block. See Section 4.4.1 [Mark], page 30.

v’ can appear in place of ‘M’ if you are currently marking a vertical block. See Section 4.4.2
[Mark Vert], page 30.

‘R’ appears if you are currently recording a macro. See Section 4.6.1 [Record], page 36.

‘P’ appears if the PreserveCR flag is true. See Section 4.9.19 [PreserveCR], page 45.

‘c’ appears if the CRLF flag is true. See Section 4.9.20 [CRLF], page 45.

‘@’ appears if UTF-8 I/O is enabled. See Section 4.9.33 [UTFSIO], page 49.
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‘a/8/u’ denotes the current document encoding—US-ASCII, 8-bit or UTF-8. See Section 4.9.31
[UTF8], page 48.

* appears if the document has been modified since the last save, or if the Modi fied command
was issued to set this flag. See Section 4.9.29 [Modified], page 47.

Note that sometimes ne needs to communicate some message to you. The message is usually written
over the status bar, where it stays until you do something. Any action such as moving the cursor or
inserting a character will restore the normal status bar.

3.3 The Input Line

The bottom line of the screen is usually occupied by the status bar (see Section 3.2 [The Status Bar],
page 12). However, whenever ne prompts you for a command or file name or asks you to confirm some
action, the bottom line becomes the input line. You can see this because a prompt is displayed at the start
of the line, suggesting what kind of input is required. (Prompts always ends with a colon, so it is easy to
distinguish them from error messages, which overwrite the status bar from time to time.)

ne uses the input line in two essentially different ways: immediate input and long input. You can
easily distinguish between these two modes because in immediate input mode the cursor is not on the
input line, while for long input mode it is.

Immediate input is used whenever ne needs you to specify a simple choice that can be expressed by
one character (for example, ‘y’ or ‘n’). When you type the character, ne will immediately accept and
use your input. Most immediate inputs display a character just after the prompt. This character is the
default response, which is used if you just press the RETURN key. Note that immediate input is not case
sensitive. Moreover, if a yes/no choice is requested, anything other than ‘y’” will be considered a negative
response.

Long input is used when a whole string is required. You can enter and edit your response to long
inputs like a line of text in a document. Most key bindings related to line editing work on the command
line exactly as they do in a document. This is true even of custom key bindings. Just edit as you are used
to. Moreover, the you can paste the first line of the current clip using the keystroke that is bound to the
Paste command, usually cONTROL-V. If your long input is longer than the screen width, the input line
scrolls to accommodate your text so you can input very long lines even on small monitors. (There is a
limit of 2048 characters.)

The default response to a long input is the response you gave to the previous long input. Your first
action when presented with a long input will either erase the default response or allow you to edit it. If
the first thing you type is a printing character, the default response will be erased. Anything else (cursor
movement for example) will allow you to edit it further.

Long input also lets you access your previous long input responses with the up and down cursor
commands (or with wider movement commands, such as start/end of file, page up/down, etc.). Once you
find a previous input you like, you can edit it further. Long input history is not document specific, so you
can recall any of your inputs regardless of which document was active when you entered it. Furthermore,
ne saves the most recent long inputs in ‘~/.ne/.history’ when you end your ne session and loads
them again when you begin another ne session.

When asked to input a number, you can choose between decimal, octal and hexadecimal notation
in the standard way: a number starting with ‘0’ is considered in octal, a number starting with ‘0x’ is
considered in hexadecimal, and in all other cases decimal base is assumed.

Whenever a file name is requested, you can type a partial file name and complete it with the TAB
key. ne will scan the current directory (or the directory that you partially specified) and search for the
files matching your partial suggestion. The longest prefix common to all such files will be copied to
the input line (ne will beep if no completion exists). It’s easier done than said—just try. If you press
TAB again, you will be brought into the file requester: only the files and directories matching your
partial specification will appear, and as usual you will be able to navigate and select a file or escape. See
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Section 3.5 [The Requester], page 15. Note that ne considers the last word on the input line the partial
file name to complete, no matter where the cursor is currently (you must use quotes if the name contains
spaces, even if it is the only item on the input line).

Complete long input with the RETURN key. You can cancel a long input using F1, ESCAPE,
ESCAPE-ESCAPE or any key that is bound to the Escape command. The effect will vary depend-
ing on what your were requested to input, but the execution of the command requiring the input will
stop.

3.4 The Command Line

The command line is a typical (topical) way of controlling an editor on character driven systems. It has
some advantages over menus in terms of access speed, but it is not desirable from a user interface point
of view. ne has a command line that should be used whenever strange features have to be accessed, or
whenever you want to use a command that you are familiar with and that is not bound to any key.

You have two ways to access the command line: by activating the menu and typing a colon (*:’) or by
typing CONTROL-K (or any key that is bound to the Exec command; see Section 4.12.4 [Exec], page 55).
The first method will work regardless of any key binding configuration if you activate the menus with
the ESCAPE key since that key cannot be reconfigured. Of course, there is also a menu entry that does
the same job.

Once you activate the command line, the status bar will turn into an input line (see Section 3.3 [The
Input Line], page 14) with a ‘Command:’ prompt waiting for you to do a long input. In other words, you
can now type any command (possibly with arguments), and when you press RETURN, the command
will be executed.

If the command you specify does not appear in ne’s internal tables, it is considered to be the name of
a macro. See Section 2.6 [Basic Macros], page 7, for details.

3.5 The Requester

In various situations, ne needs to ask you to choose one string from several (where “several” can mean
a lot). For this kind of event, the requester is issued. The requester displays the strings in as many
columns as possible and lets you move with the cursor from one string to another. The strings can fill
many screens, which are handled as consecutive pages. Most navigation keys work exactly as in normal
editing. This is true even of custom key bindings. Thus, for instance, you can page up and down through
the list with coNTROL-P and CONTROL-N (in the standard keyboard configuration).

A special feature is bound to printing characters: the requester progressively advances to entries that
match the characters you type without regard to case. You can use BACKSPACE to incrementally undo
your matched characters. This progressive matching works in two modes which you can switch between
on the fly with either the INSERT or DELETE key. In the default mode, the cursor indicating your current
selection simply advances to the next matching entry (if there is one). In the other mode, all entries which
don’t match the characters you’ve entered are removed from the list so you only see the matching entries.
The BACKSPACE key incrementally returns them to your list as your match becomes less specific. You
can switch between the two modes as often as you wish while searching for your desired entry. This lets
you quickly navigate large lists to get to the entries you really want.

One example of a requester is the list of commands appearing when you use the Help command.
Another is the list of document words matching a prefix given to the AutoComplete command. A third
example is the file requester that ne issues whenever a file operation is going to take place. In this case,
pressing RETURN while on a directory name will enter that directory and refresh the requester with that
directory’s entries. Note also that, should the requester take too long to appear, you can interrupt the
directory scanning with CONTROL-\. However, the listing will likely be incomplete.

Yet another example of a requester is the list of documents you currently have open. This requester
is displayed when you use the Select. .. entry from the Documents menu, or invoke the SelectDoc
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command with the F4 key. Documents with unsaved changes will be bold (if your terminal supports
bold) and marked with an asterisk. These documents are generally listed in the order they were opened.
However, in this requester you can reorder these documents by using the keys bound to the NextDoc and
PrevDoc commands, usually F2 and F3. Any document reordering and selection will only take effect if
you exit the requester with the RETURN key. You can also close unmodified documents without leaving
the SelectDoc requester by using the key bound to the CloseDoc command, usually CONTROL-Q.
Closing the last document this way will cause ne to exit.

Regardless of the type of requester, you can confirm your selection with RETURN just as with the
input line (see Section 3.3 [The Input Line], page 14), or you can escape the requester without making a
selection with F1 or the ESCAPE key (or whatever has been bound to the Escape command).

Moreover, if you are selecting a file name through the requester there is a third possibility: by escaping
with the TAB key, the file or directory name that the cursor is currently on will be copied to the input
line. This allows you to choose an existing name with TAB and modify the name on the input line before
hitting RETURN.

Note that there are two items that always appear at the top of a file requester: ‘. /” and ‘. ./’. The
first one represents the current directory and can be used to force a reread of the directory. The second
one represents the parent directory and can be used to move up by one directory level.

The path to file names and direct